Chapter 803

Spearman’s Rank Correlation Tests (Simulation)

Introduction

This procedure analyzes the power and significance level of Spearman’s Rank Correlation significance test using Monte Carlo simulation. This test is used to test whether the rank correlation is non-zero. For each scenario that is set up, two simulations are run. One simulation estimates the significance level and the other estimates the power.

Spearman’s rho, $\rho_s$, is a popular statistic for describing the strength of the monotonic relationship between two variables. It ranges between plus and minus one.

Technical Details

Computer simulation allows us to estimate the power and significance level that is actually achieved by a test procedure in situations that are not mathematically tractable. Computer simulation was once limited to mainframe computers. But, in recent years, as computer speeds have increased, simulation studies can be completed on desktop and laptop computers in a reasonable period of time.

The steps to a simulation study are

1. Specify the test procedure and the test statistic. This includes the significance level, sample size, and underlying data distributions.

2. Generate a random sample of points (X, Y) from the bivariate distribution specified by the alternative hypothesis. Calculate the test statistic from the simulated data and determine if the null hypothesis is accepted or rejected. These samples are used to calculate the power of the test. In the case of paired data, the individual values are simulated so that they exhibit the specified amount of correlation.

3. Generate a second random sample of points (X, Y) from the bivariate distribution specified by the null hypothesis. Calculate the test statistic from the simulated data and determine if the null hypothesis is accepted or rejected. These samples are used to calculate the significance-level of the test. In the case of paired data, the individual values are simulated so that they exhibit the specified amount of correlation.

4. Repeat steps 2 and 3 several thousand times, tabulating the number of times the simulated data leads to a rejection of the null hypothesis. The power is the proportion of simulated samples in step 2 that lead to rejection. The significance level is the proportion of simulated samples in step 3 that lead to rejection.
Simulating Paired Distributions

In this routine, paired data may be generated from the bivariate normal distribution or from two specified marginal distributions. In the latter case, the simulation should mimic the actual data generation process as closely as possible, including the marginal distributions and the correlation between the two variables.

Obtaining paired samples from arbitrary distributions with a set correlation is difficult because the joint, bivariate distribution must be specified and simulated. Rather than specify the bivariate distribution, **PASS** requires the specification of the two marginal distributions and the correlation between them.

Monte Carlo samples with given marginal distributions and correlation are generated using the method suggested by Gentle (1998). The method begins by generating a large population of random numbers from the two distributions. Each of these populations is evaluated to determine if their means are within a small relative tolerance (0.0001) of the target mean. If the actual mean is not within the tolerance of the target mean, individual members of the population are replaced with new random numbers if the new random number moves the mean towards its target. Only a few hundred such swaps are required to bring the actual mean to within tolerance of the target mean.

The next step is to obtain the target correlation. This is accomplished by permuting one of the populations until they have the desired correlation.

The above steps provide a large pool (ten thousand to one million items) of random number pairs that exhibit the desired characteristics. This pool is then sampled at random using the uniform distribution to obtain the random number pairs used in the simulation.

This algorithm may be stated as follows.

1. Draw individual samples of size M from the two distributions where M is a large number over 10,000. Adjust these samples so that they have the specified mean and standard deviation. Label these samples A and B. Create an index of the values of A and B according to the order in which they are generated. Thus, the first value of A and the first value of B are indexed as one, the second values of A and B are indexed as two, and so on up to the final set which is indexed as M.

2. Compute the product-moment correlation between the two generated variates.

3. If the computed product-moment correlation is within a small tolerance (usually less than 0.001) of the specified correlation, go to step 7.

4. Select two indices (I and J) at random using uniform random numbers.

5. Determine what will happen to the product-moment correlation if $B_i$ is swapped with $B_j$. If the swap will result in a correlation that is closer to the target value, swap the indices and proceed to step 6. Otherwise, go to step 4.

6. If the computed product-moment correlation is within the desired tolerance of the target correlation, go to step 7. Otherwise, go to step 4.

7. End with a population with the required marginal distributions and correlation.

A population created by this procedure tends to exhibit more variation in the tails of the distribution than in the center. Hence, the results using the bivariate normal option will be slightly different from those obtained when a custom model with two normal distributions is used.
Test Statistic

This section describes the test statistic that is used.

**Spearman’s Rank Correlation Coefficient**

Spearman’s rank correlation coefficient is calculated from a sample of N data pairs (X, Y) by first creating a variable U as the ranks of X and a variable V as the ranks of Y (ties replaced with average ranks). Spearman’s correlation is then calculated from U and V using

\[
r_s = \frac{\sum (U - \bar{U})(V - \bar{V})}{\sqrt{\sum (U - \bar{U})^2 \sum (V - \bar{V})^2}}
\]

The distribution of \(r_s\) assuming X and Y follow the bivariate normal distribution is known and available in PASS. It can be used to determine critical values for \(r\).

**Test Statistic**

Since Spearman’s rho is a special case of Pearson’s product-moment correlation, the following t-test is recommended N is at least 19. See Kendall and Gibbons (1990).

\[
t_{N-2} = \frac{r_s \sqrt{N - 2}}{\sqrt{1 - r_s^2}}
\]

The distribution of \(t\) is approximated by Students t distribution with N – 2 degrees of freedom.

**Relationship Between Spearman’s Rho and Pearson’s Correlation**

Since Spearman’s rho is calculated from the ranks of X and Y and Pearson’s product-moment correlation is calculated from the original values, these two correlations will seldom be equal. All of the simulation distributions are based on the Pearson product-moment correlation, so this is the correlation that you will specify in the as \(\rho_1\) in the program. To avoid confusion, we will refer to the Pearson correlation as \(\rho\) and the corresponding Spearman’s correlation calculated on the ranks as \(\phi\).

**Test Procedure**

The testing procedure is as follows. \(H_0\) is the null hypothesis that \(\phi\) is zero. \(H_1\) represents the alternative hypothesis that the actual \(\phi\) is non-zero. Choose a value \(t_\alpha\), based on Student’s t distribution, so that the probability of rejecting \(H_0\) when \(H_0\) is true is equal to a specified value, \(\alpha\).

Select a sample of \(N\) items from the population and compute their test statistic t. If \(t > t_\alpha\) reject the null hypothesis that \(\phi = 0\) in favor of an alternative hypothesis that \(\phi > 0\).

The power is the probability of rejecting \(H_0\) when the true rank correlation is \(\phi_1\). Unfortunately, the correlation that is entered into PASS is \(\rho_1\), not \(\phi_1\).
**Procedure Options**

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

**Design Tab**

The Design tab contains most of the parameters and options that you will be concerned with.

**Solve For**

This option specifies whether you want to solve for sample size or power.

Select *Sample Size* when you want to determine the sample size needed to achieve a given power and alpha error level.

Select *Power* when you want to calculate the power for a given power.

**Hypothesis and Simulations**

**Alternative Hypothesis**

This option specifies the alternative hypothesis. This implicitly specifies the direction of the hypothesis test. The null hypothesis is $H_0: \rho_s = 0$.

Note that the alternative hypothesis enters into power calculations by specifying the rejection region of the hypothesis test. Its accuracy is critical.

Possible selections are:

- $\rho_s \neq 0$
  
  This is the most common selection. It yields the *two-tailed* test. Use this option when you are testing whether the correlation values are different, but you do not want to specify beforehand which correlation is larger.

- $\rho_s > 0$
  
  This option yields a *one-tailed* test.

- $\rho_s < 0$
  
  This option also yields a *one-tailed* test.

**Simulations**

This option specifies the number of simulations, $M$. The larger the number of simulations, the longer the running time and the more accurate the results.

The precision of the simulated power estimates are calculated from the binomial distribution. Thus, confidence intervals may be constructed for various power values using the binomial distribution. The following table gives an estimate of the precision that is achieved for various simulation sizes when the power is either 0.50 or 0.95.

The table values are interpreted as follows: a 95% confidence interval of the true power is given by the power reported by the simulation plus and minus the ‘Precision’ amount given in the table.
<table>
<thead>
<tr>
<th>Simulation Size</th>
<th>Precision when Power = 0.50</th>
<th>Precision when Power = 0.95</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>0.100</td>
<td>0.044</td>
</tr>
<tr>
<td>500</td>
<td>0.045</td>
<td>0.019</td>
</tr>
<tr>
<td>1000</td>
<td>0.032</td>
<td>0.014</td>
</tr>
<tr>
<td>2000</td>
<td>0.022</td>
<td>0.010</td>
</tr>
<tr>
<td>5000</td>
<td>0.014</td>
<td>0.006</td>
</tr>
<tr>
<td>10000</td>
<td>0.010</td>
<td>0.004</td>
</tr>
<tr>
<td>50000</td>
<td>0.004</td>
<td>0.002</td>
</tr>
<tr>
<td>100000</td>
<td>0.003</td>
<td>0.001</td>
</tr>
</tbody>
</table>

Notice that a simulation size of 1000 gives a precision of plus or minus 0.01 when the true power is 0.95. Also note that as the simulation size is increased beyond 5000, there is only a small amount of additional accuracy achieved.

**Random Seed**

Specify a numeric seed for random number generation. This value must be between 0 and 2147483647 and may be a decimal number.

**Obtaining a Computer-Generated Random Seed**

Enter Random, 0, or leave this option blank for a randomly generated seed based on the computer’s internal clock. If a randomly generated seed is used, its value will be displayed in the output.

**Using a Non-Zero Random Seed**

If you enter a non-zero random seed, the same random sequence will be generated with each run and the output will not change. This is often used to replicate previous results.

**Power and Alpha (or Alpha)**

**Power**

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal correlations when in fact they are different.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

**Alpha**

This option specifies one or more values for the probability of a type-I error. A type-I error occurs when you reject the null hypothesis of equal correlations when in fact they are equal.

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

**Sample Size**

**N (Sample Size)**

The number of observations in the sample. Each observation is made up of two values: one for \( X \) and one for \( Y \).
Correlations

ρ1 (Correlation|H1)
Specify the value of ρ₁, the population product-moment correlation under the alternative hypothesis. Note that the range of the correlation is between plus and minus one. The difference between 0 and ρ₁ is being tested by this significance test.

You can enter a range of values separated by blanks or commas.

Note that this is the value of the Pearson product-moment correlation, not Spearman’s rank correlation.

Power and Alpha Simulations

Distribution
Specify whether a bivariate normal or a custom bivariate distribution is used to generate the data. The possible choices are:

- **Bivariate Normal**
  Bivariate normal distributions are simulated with zero means, unit variances, and correlations ρ₀ and ρ₁ to create the alpha and power simulations, respectively.

- **Custom**
  A bivariate distribution is specified by setting the two marginal distributions and their correlation (ρ₀ for the alpha simulation and ρ₁ for the power simulation).

  The algorithm proceeds by generating a pool of several thousand random pairs from the X and Y distributions. To achieve the desired correlation, pairs of points are randomly selected and their X values are swapped if the switch results in an overall correlation closer to the desired value.

  When applied to normal data, this algorithm results in a bivariate population that is narrower in the center and wider in the tails than the standard bivariate normal.

Custom Power and Alpha Simulations
These options specify the distributions of X and Y to be used in the power simulation (on the left) and the alpha simulation (on the right). All distributions are specified with the same syntax.

Distribution
Specify the distribution of each variable under the alternative hypothesis, H₁, on the left and under the null hypothesis, H₀, on the right.

For convenience in specifying a range of values, the parameters of a distribution can be specified using numbers or letters. If letters are used, their values are specified in the Parameter Values boxes below.

Following is a list of the distributions that are available and the syntax used to specify them. Each of the parameters should be replaced with a number or parameter name.

Distributions with Common Parameters

- Beta(Shape₁, Shape₂, Min, Max)
- Binomial(P,N)
- Cauchy(Mean,Scale)
- Constant(Value)
- Exponential(Mean)
Spearman’s Rank Correlation Tests (Simulation)

Gamma(Shape,Scale)
Gumbel(Location,Scale)
Laplace(Location,Scale)
Logistic(Location,Scale)
Lognormal(Mu,Sigma)
Multinomial(P1,P2,P3,...,Pk)
Normal(Mean,Sigma)
Poisson(Mean)
TukeyGH(Mu,S,G,H)
Uniform(Min, Max)
Weibull(Shape,Scale)

Distributions with Mean and SD Parameters
BetaMS(Mean,SD,Min,Max)
BinomialMS(Mean,N)
GammaMS(Mean,SD)
GumbelMS(Mean,SD)
LaplaceMS(Mean,SD)
LogisticMS(Mean,SD)
LognormalMS(Mean,SD)
UniformMS(Mean,SD)
WeibullMS(Mean,SD)

Details of writing mixture distributions, combined distributions, and compound distributions are found in the chapter on Data Simulation and will not be repeated here.

Power and Alpha Simulations – Parameter Values for X and Y Distributions
These options specify the names and values for the parameters used in the distributions.

Name
Up to five sets of named parameter values may be used in the simulation distributions. This option lets you select an appropriate name for each set of values. Possible names are

- A to Z
  You might use these letters for location, shape, and scale parameters.

Value(s)
These values are substituted for the Parameter Name (M1, M2, SD, A, B, C, etc.) in the simulation distributions. If more than one value is entered, a separate calculation is made for each value.

You can enter a single value such as “2” or a series of values such as “0 2 3” or “0 to 3 by 1”.
Simulations Tab

The options on this tab control the generation of the random numbers. For complicated distributions, a large pool of random numbers from the specified distributions is generated. Each of these pools is evaluated to determine if its mean is within a small relative tolerance (0.0001) of the target mean. If the actual mean is not within the tolerance of the target mean, individual members of the population are replaced with new random numbers if the new random number moves the mean towards its target. Only a few hundred such swaps are required to bring the actual mean to within tolerance of the target mean. This population is then sampled with replacement using the uniform distribution. We have found that this method works well as long as the size of the pool is at least the maximum of twice the number of simulated samples desired and 10,000.

Random Numbers

Random Number Pool Size
This is the size of the pool of values from which the random samples will be drawn. Pools should be at least the minimum of 10,000 and twice the number of simulations. You can enter Automatic and an appropriate value will be calculated.

If you do not want to draw numbers from a pool, enter 0 here.

Correlation

Maximum Switches
This option specifies the maximum number of index switches that can be made while searching for a permutation of Y that yields a correlation within the specified tolerance.

A value near 5000000 is needed when the correlation is large.

Correlation Tolerance
Specify the amount above and below the target correlation that will still let a particular index-permutation to be selected as the bivariate population.

For example, if you have selected a correlation of 0.3 and you set this tolerance to 0.001, then permutations will continue until one is found which yields a correlation between 0.299 and 0.301.

Recommended: 0.001
Valid Values: 0 to 0.99.
**Example 1 – Finding the Power**

Suppose a study will be run to test whether the correlation between forced vital capacity (X) and forced expiratory value (Y) in a particular population is non-zero. Find the power if $\rho_1 = 0.20$ and 0.30, alpha is 0.05, and $N = 20, 60, 100$.

**Setup**

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open **Example 1** by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>$\rho_s \neq 0$</td>
</tr>
<tr>
<td>Simulations</td>
<td>5000</td>
</tr>
<tr>
<td>Random Seed</td>
<td>Blank or Random</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N (Sample Size)</td>
<td>20 60 100</td>
</tr>
<tr>
<td>$\rho_1$ (Correlation[H1])</td>
<td>0.2 0.3</td>
</tr>
<tr>
<td>Distribution</td>
<td>Bivariate Normal</td>
</tr>
</tbody>
</table>

**Annotated Output**

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Simulation Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variables</td>
</tr>
<tr>
<td>X and Y</td>
</tr>
<tr>
<td>Distribution</td>
</tr>
<tr>
<td>Bivariate Normal</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Alpha (H0)</td>
</tr>
<tr>
<td>Simulation</td>
</tr>
<tr>
<td>Distribution</td>
</tr>
<tr>
<td>Bivariate Normal</td>
</tr>
<tr>
<td>Random Number Pool Size</td>
</tr>
<tr>
<td>Number of Simulations</td>
</tr>
</tbody>
</table>

**Numeric Results for Testing Correlation Hypotheses: H0: $\rho_s = 0$; H1: $\rho_s \neq 0$**

<table>
<thead>
<tr>
<th>Sample Size</th>
<th>N</th>
<th>Power (H1)</th>
<th>$\rho_0$</th>
<th>$\rho_1$</th>
<th>Target Alpha</th>
<th>Actual Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>20</td>
<td>0.113</td>
<td>0.000</td>
<td>0.200</td>
<td>0.050</td>
<td>0.051</td>
</tr>
<tr>
<td>2</td>
<td>60</td>
<td>0.339</td>
<td>0.000</td>
<td>0.200</td>
<td>0.050</td>
<td>0.051</td>
</tr>
<tr>
<td>3</td>
<td>100</td>
<td>0.439</td>
<td>0.000</td>
<td>0.200</td>
<td>0.050</td>
<td>0.053</td>
</tr>
<tr>
<td>4</td>
<td>20</td>
<td>0.249</td>
<td>0.000</td>
<td>0.300</td>
<td>0.050</td>
<td>0.049</td>
</tr>
<tr>
<td>5</td>
<td>60</td>
<td>0.597</td>
<td>0.000</td>
<td>0.300</td>
<td>0.050</td>
<td>0.049</td>
</tr>
<tr>
<td>6</td>
<td>100</td>
<td>0.822</td>
<td>0.000</td>
<td>0.300</td>
<td>0.050</td>
<td>0.054</td>
</tr>
</tbody>
</table>

Run Time: 5.29 seconds.

**References**


Spearman's Rank Correlation Tests (Simulation)

Report Definitions
N is the size of the sample drawn from the population. It is the number of X-Y data points in a sample.
Power is the probability of rejecting a false null hypothesis. It is calculated by the power simulation.
\( \rho_0 \) is the Pearson correlation coefficient assuming the null hypothesis, H0. This is the value being tested.
\( \rho_1 \) is the Pearson correlation coefficient assuming the alternative hypothesis, H1. This is the value at which the power is computed.
Target Alpha is the probability of rejecting a true null hypothesis. It is set by the user.
Actual Alpha is the alpha level that was actually achieved by the experiment. It is calculated by the alpha simulation.
Beta is the probability of accepting a false null hypothesis.

Summary Statements
A sample size of 20 achieves 11% power to detect a Pearson correlation of 0.200 using a two-sided hypothesis test with a significance level of 0.050. These results are based on 5000 Monte Carlo samples from the bivariate normal distribution under the alternative hypothesis.

Power and Alpha Confidence Intervals from Simulations

<table>
<thead>
<tr>
<th>Row</th>
<th>Sample Size</th>
<th>N</th>
<th>Lower Limit of 95% Power</th>
<th>Upper Limit of 95% Power</th>
<th>Lower Limit of 95% Target Alpha</th>
<th>Upper Limit of 95% Target Alpha</th>
<th>Lower Limit of 95% Actual Alpha</th>
<th>Upper Limit of 95% Actual Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20</td>
<td>0.113</td>
<td>0.105</td>
<td>0.122</td>
<td>0.050</td>
<td>0.051</td>
<td>0.045</td>
<td>0.057</td>
</tr>
<tr>
<td>2</td>
<td>60</td>
<td>0.339</td>
<td>0.326</td>
<td>0.352</td>
<td>0.050</td>
<td>0.051</td>
<td>0.045</td>
<td>0.057</td>
</tr>
<tr>
<td>3</td>
<td>100</td>
<td>0.439</td>
<td>0.425</td>
<td>0.452</td>
<td>0.050</td>
<td>0.053</td>
<td>0.047</td>
<td>0.059</td>
</tr>
<tr>
<td>4</td>
<td>20</td>
<td>0.249</td>
<td>0.237</td>
<td>0.261</td>
<td>0.050</td>
<td>0.049</td>
<td>0.043</td>
<td>0.055</td>
</tr>
<tr>
<td>5</td>
<td>60</td>
<td>0.597</td>
<td>0.583</td>
<td>0.611</td>
<td>0.050</td>
<td>0.049</td>
<td>0.043</td>
<td>0.055</td>
</tr>
<tr>
<td>6</td>
<td>100</td>
<td>0.822</td>
<td>0.812</td>
<td>0.833</td>
<td>0.050</td>
<td>0.054</td>
<td>0.048</td>
<td>0.060</td>
</tr>
</tbody>
</table>

Definitions of the Power and Alpha Confidence Intervals Report
N is the size of the sample drawn from the population. It is the number of X-Y data points in a sample.
Power is the probability of rejecting H0 when it is false. This is the actual value calculated by the power simulation.
Lower and Upper Limits of a 95% C.I. for Power are the limits of an exact, 95% confidence interval for power based on the binomial distribution. They are calculated from the power simulation.
Target Alpha is the desired probability of rejecting a true null hypothesis at which the tests were run.
Actual Alpha is the alpha achieved by the test as calculated by the alpha simulation.
Lower and Upper Limits of a 95% C.I. for Alpha are the limits of an exact, 95% confidence interval for alpha based on the binomial distribution. They are calculated from the alpha simulation.

The Numeric Results report gives the basic results. The Power and Alpha Confidence Intervals report provides a confidence interval for each power and alpha value that was simulated. Definitions follow the reports.
These plots show the relationship between power and sample size in this example.
Example 2 – Validation using Zar (1984)

Zar (1984) page 312 presents an example in which the power of a Pearson’s correlation coefficient is calculated. If $N = 12$, $alpha = 0.05$, $\rho_0 = 0$, and $\rho_1 = 0.866$, Zar calculates a power of 98% for a two-sided test. We know that the power of Spearman’s rho should be similar to that of Pearson’s correlation.

For reproducibility, we’ll use a random seed of 5817581.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>$\rho_s \neq 0$</td>
</tr>
<tr>
<td>Simulations</td>
<td>50000</td>
</tr>
<tr>
<td>Random Seed</td>
<td>5817581</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N (Sample Size)</td>
<td>12</td>
</tr>
<tr>
<td>$\rho_1$ (Correlation</td>
<td>H0)</td>
</tr>
<tr>
<td>Distribution</td>
<td>Bivariate Normal</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for Testing Correlation Hypotheses: $H_0$: $\rho_s = 0$; $H_1$: $\rho_s \neq 0$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Size</td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td>1</td>
</tr>
</tbody>
</table>

The power of 0.951 is a little less than Zar’s result, as we would expect.